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7.0 Model Pepejal 3D

7.1 Pengenalan

Seperti yang telah dipelajari di dalam Bab 1 sistem koordinat di dalam AutoCAD mempunyai
paksi koordinat ketiga iaitu paksi Z. Namun paksi Z tidak digunakan di dalam lukisan 2D
walaupun paksi tersebut wujud. Lukisan 3D yang akan dipelajari ini akan menggunakan paksi Z
selain dari paksi X dan Y. Ketiga-tiga paksi ini penting untuk menghasilkan lukisan 3D.

7.2 Okjektif mempelajari lukisan 3D

1. Mengenali semua alatan yang digunakan bagi membina model pepejal 3D.
2. Membina lukisan dari 2D sebagai tapak asas kepada model pejal 3D.
3. Membina model pepejal dengan menggunakan semua alatan di dalam Solid toolbar.

Di dalam menghasilkan lukisan model pepejal 3D anda harus faham terdapat beberapa model
pepejal yang perlu dihasilkan dan akhirnya digabungkan menjadi lengkap untuk menghasilkan
lukisan seperti rangka kapal terbang seperti ditunjukkan di dalam Rajah 7.1.

Rajah 7.1 Beberapa model pepejal 3D telah digabungkan menjadi sebuah rangka kapal
terbang.

7.3 Lukisan 2D kepada 3D

Perkara pertama yang perlu dipelajari ialah dengan kaedah menukarkan dari lukisan 2D
kepada lukisan 3D. Berikut adalah langkah-langkah untuk menghasilkan lukisan 3D:

1. Pergi ke Menu bar dan klik View,
2. Klik 3D View,
3. Klik SW Isometrik.

Di dalam 3D View terdapat arahan lain yang dipaparkan seperti ditunjukkan dalam Rajah 7.2.
Selain SW Isometrik terdapat tiga lagi arahan iaitu SE Isometrik, NE Isometrik dan NW
Isometrik. Kesemua arahan ini merupakan arah pandangan yang dikehendaki seperti
ditunjukkan dalam Rajah 7.3. Pandangan ini bukanlah pandangan utama untuk melukis 3D
tetapi ianya bertujuan untuk melihat lukisan 3D secara keseluruhan melibatkan tiga paksi X, Y
dan Z. Lukisan 3D boleh juga dilukis di dalam pandangan 2D tetapi paksi Z tidak kelihatan.
Perkara kedua yang perlu dipelajari ialah Toolbars atau Alatan-alatan yang perlu difahami
untuk melukis 3D.
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Rajah 7.2 Arahan menggunakan SW Isometrik

SW Isometrik SE Isometrik NE Isometrik NW Isometrik

Rajah 7.3 Paparan apabila menggunakan 3D View.

7.4 Tools untuk melukis 3D

Terdapat pelbagai jenis alatan yang ada di dalam menghasilkan lukisan 3D tetapi hanya
sebahagian sahaja yang perlu dipelajari bagi melukis model Pepejal 3D bagi tujuan permulaan.
Contoh alatan-alatan yang digunakan seperti:

1. Solid Toolbar
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2. UCS Toolbar

3. Solid Editing Toolbar

Tiga jenis alatan yang perlu dipelajari untuk melukis model pepejal 3D dan alatan ini perlu
diletakkan di dalam ruang lukisan AutoCAD. Terdapat dua kaedah untuk memanggil alatan-
alatan ini, kaedah pertama dengan menggunakan Menu View dan klik Toolbars. Kaedah kedua
dengan tekan butang kanan tetikus pada mana-mana ikon dan cari tiga jenis alatan-alatan
seperti di atas.

Tidak semua arahan di dalam alatan perlu dipelajari untuk menghasilkan lukisan 3D. Sebagai
contoh, untuk melukis rangka kapal terbang seperti dalam Rajah 7.1 arahan yang digunakan
ialah Extrude dalam Solid Toolbar dan UCS Toolbar sahaja yang digunakan.

Format arahan kawalan Solids adalah seperti berikut:

Butang Tool Fungsi

Box Membina kotak pepejal.

Sphere Membina sfera pepejal .

Cylinder Membina silinder pepejal.

Cone Membina kon pepejal.

Wedge Membina bucu pepejal.

Torus Membina torus pepejal.

Extrude Penarikan pepejal dari profil 2D.

Revolve Putaran pada paksi yang diberikan pada profil 2D.

Slice Membenarkan anda potong objek pepejal pada satah yang diberikan.

Section Membina bahagian keratan objek pepejal pada satah intersection.

Interfere Membina pepejal 3D komposit berdasarkan pada isipadu dua atau lebih pepejal.

Setup
Drawing

Menggunakan teknik unjuran Ortografik untuk bentangkan pandangan dalam
mode 3D.

Setup View Menghasilkan profil 2D dan keratan menggunakan arahan SOLVIEW

Setup Profile Menghasilkan pandanagan profil untuk mode model 3D.

7.4.1 Extrude (Penarikan)

Extrude bermaksud penarikan satu bahagian pepejal menerusi paksi Z. Ikon Extrude berada di
dalam Solid Toolbar seperti ditunjukkan dalam Rajah 7.4. Dengan menggunakan tetikus, klik
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butang kiri pada ikon Extrude dan arahan seterusnya hendaklah dibaca di dalam Comman
Line.

Rajah 7.4 Ikon Extrude.

Bagi menghasilkan objek seperti di dalam Rajah 7.5 berikut adalah langkah-langkah yang perlu
dilakukan;

1. Perlu menghasilkan lukisan Geometri yang telah dipelajari sebelum ini sebagai tapak
asas bagi binaan model 3D. Tapak ini hendaklah dilukis di dalam satah X-Y sama ada
menggunakan lukisan 2D atau 3D seperti yang telah dijelaskan dalam bahagian awal
bab ini.

Rajah 7.5 Bongkah pepejal atau model pepejal 3D menggunakan Extrude dengan
ketinggian 50 mm dengan sudut kecondongan 0.

Model di atas terlebih dahulu dihasilkan dengan melukis tapak seperti Rajah 7.6 dalam satah
X-Y samada menggunakan lukisan 2D atau 3D. Rajah seterusnya ditunjukkan lukisan 3D
seperti Rajah 7.7.

50 mm
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Rajah 7.6 Lukisan Geometri dalam 2D.

Rajah 7.7 Lukisan Geometri dalam 3D.

2. Selepas lukisan geometri dihasilkan seterusnya gunakan arahan PEDIT (Polyline Edit)
yang bermaksud menyambungkan satu garisan dengan garisan yang lain.
Dalam Command Line taipkan Pedit dan tekan butang enter.
Arahan seterusnya akan terpapar di dalam Command Line;

Taipkan PEDIT dan tekan butang Enter.
Select polyline or [Multiple] pilih satu garisan yang bertanda A.
Do you want to turn it into one? <Y> tekan butang enter untuk Yes
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype

A

A1
2

3

4

5
6

7
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gen/Undo]: taip j untuk join iaitu sambung
Select objects: pilih salah satu garisan sahaja atau garisan 1
Select objects: pilih garisan ke-2
Select objects: pilih garisan ke-3
Select objects: pilih garisan ke-4
Select objects: pilih garisan ke-5
Select objects: pilih garisan ke-6
Select objects: pilih garisan ke-7
Select objects: pilih garisan terakhir iaitu titik A semula
Select objects: tekan butang enter kerana tiada lagi garisan hendak dipilih.
7 segments added to polyline
Enter an option [Open/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo]:
tekan butang enter dua kali.

3. Arahan seterusnya ialah klik ikon Extrude.
Select objects: klik pada garisan yang telah dihasilkan
Select objects: tekan butang enter bermaksud tiada lagi objek yang dipilih.
Specify height of extrusion or [Path]: masukkan ketinggian objek iaitu 50 mm.
Specify angle of taper for extrusion <0>: tekan butang enter.

Dan akhirnya terbentuklah objek seperti Rajah 7.5.

7.4.2 Putaran (Revolve)

Arahan pepejal putaran bermaksud membentuk objek pepejal dengan membuat putaran pada
paksi tertentu yang telah dikenal pasti. Seperti mana menghasilkan tapak bagi arahan Extrude,
arahan Revolve memerlukan garis poli dalam keadaan tertutup dan tiada segmen yang
bertindih di antara satu sama lain.
Bagi menghasilkan lukisan seperti Rajah 7.8 terlebih dahulu lukiskan bentuk geometri iaitu
tapak pada satah X-Y seperti Rajah 7.9

Rajah 7.8 Objek yang mempunyai bentuk simetri sahaja boleh dihasilkan dengan arahan
Revolve.
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Rajah 7.9 Tapak asas bagi lukisan geometri sebelum melakukan arahan PEDIT.

Langkah-langkah yang perlu dilakukan untuk menghasilkan lukisan di atas setelah melakukan
arahan Pedit sama seperti langkah melakukan Extrude;

Setelah melakukan Pedit.
Klik ikon Revolve dan baca arahan di dalam Command Line;
Select objects: klik pada garisan poli yang telah dihasilkan
Select objects: tekan butang enter bermaksud tiada lagi objek yang dipilih.
Specify start point for axis of revolution or define axis by [Object/X (axis)/Y (axis)]: pilih
satu titik yang bertanda A.
Specify endpoint of axis: pilih satu titik yang bertanda B
Specify angle of revolution <360>: tekan enter

Setelah arahan Pedit dilakukan. Sudut putaran 90 putaran lawan arah jam.

Rajah 7.10 Arahan Revolve dengan sudut putaran 90.

7.5 Sistem Koordinat Pengguna (UCS – User Coordinate System)

Sistem Koordinat Pengguna atau lebih mudah dikenali dengan UCS merupakan arahan untuk
menentukan arah dan sudut putaran kordinat X-Y-Z. UCS mempunyai beberapa arahan lain
yang lazim digunakan seperti View, Origin, X Axis, Y Axis dan Z Axis seperti di tunjukkan dalam
Rajah 7.11 di bawah.

A B
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Rajah 7.11 Arahan View di dalam UCS Toolbar.

UCS amat penting di dalam menghasilkan lukisan 3D sebagai contoh untuk menggunakan
arahan Extrude paksi Z digunakan sebagai panduan penarikan pepejal atau jarak ketinggian
objek tersebut. Beberapa orientasi sistem kordinat ditunjukkan dalam Rajah 7.12.

Rajah 7.12 UCS telah diputarkan pada paksi Y dengan putaran -90.

Kedudukan Orientasi UCS boleh difahami dengan mudah bagi menentukan arah dan sudut
putaran dengan menggunakan Hukum Tangan Kanan seperti dalam Rajah 7.13.

Arah paksi 3D Arah Putaran positif

Rajah 7.13 Hukum tangan kanan untuk menentukan orientasi paksi dan putaran UCS.

UCS diperlukan dalam penggunaan PEDIT kerana untuk menyatukan sesuatau garisan arahan
PEDIT hanya boleh dilakukan pada satah X-Y sahaja sebagai contoh lihat Rajah 7.14.

Z

Y

X
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Arahan PEDIT dapat dilakukan pada
satah X-Y sahaja

Putarkan UCS pada paksi X 90 iaitu
arah lawan jam menggunakan Hukum
Tangan Kanan sebelum arahan PEDIT
pada bahagian setelah diputarkan.

Rajah 7.14 UCS diputarkan mengikut Hukum Tangan Kanan.

Format arahan kawalan UCS adalah seperti berikut:

Butang Alatan Fungsi

UCS Aktifkan arahan UCS di dalam kawasann Command Prompt.

Named UCS Aktifkan kotak dialog UCS.

Previous UCS Sediakan system kordinat yang didifinasikan untuk penggunaan.

World Setkan sistem kordinat pengguna tersedia sama seperti World Coordinate System.

Object Membina UCS berpandukan objek yang dipilih.

Face UCS Membina UCS berpandukan permukaan pada objek pepejal.

View
Tetapkan satu sistem kordinat baru dengan paksi Z selari dengan arah pandangan
tersedia.

Origin Ubahkan asalan system kordinat tersedia.

Z Axis Vector Membina asas UCS baru pada dua titik yang mewakili paksi Z.

3 Point Membina UCS baru dengan mengambil tiga titik.

X Putarkan UCS pada paksi X.

Y Putarkan UCS pada paksi Y.

Z Putarkan UCS pada paksi Z.

Apply Set UCS pada pandangan spesifik.

7.6 Operasi Boolean

Untuk menggabungkan dua atau lebih objek primitif bagi membentuk sebuah pepejal yang
lengkap memerlukan operasi Boolean. Operasi Boolean berfungsi sekurang-kurangnya
memerlukan dua objek primitif pepejal. Arahan Boolean ini boleh diperolehi dalam Modify menu
di bawah Solid Editing. Juga boleh diperolehi melalui Solid Editing Toolbars. Operasi Boolean
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membenarkan anda menambah dua atau lebih objek bercantum bersama yang lebih dikenali
sebagai Union. Operasi Boolean juga membenarkan anda membuang objek yang besar seperti
menebuk lubang pada objek pepejal dengan menggunakan arahan Subtract. Akhir sekali
operasi Boolean ini boleh mengasingkan dua objek yang bercantum dengan menggunakan
arahan Intersect. Rajah 7.15 menunjukkan operasi Boolean bagi arahan Union dicapai melalui
Solid Editing.

Rajah 7.15 Arahan Union dengan klik ikon Union.

Di dalam imej di bawah iaitu Rajah 7.16 menerangkan proses menggunakan Union, Subtract
dan Intersect.

Dua pepejal sebelum disatukan. Arahan Union akan
menyatukan dua
objek kepada satu
objek pepejal.

Arahan Subtract
bertujuan untuk
menghasilkan lubang
seperti di atas

Arahan
Intersect
bertujuan
untuk
mendapatkan
bentuk
silinder.

Rajah 7.16 Penggunan Union, Subtract dan Intersect.

7.6.1 Penyatuan (Union)

Arahan penyatuan pepejal digunakan untuk menyatukan beberapa objek pepejal untuk
membentuk objek pepejal gabungan.
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Gabungkan dua objek pepejal seperti di
atas, pastikan objek tersebut sebaris.

Selepas melakukan arahan Union.

Rajah 7.18 Pembentukan model pepejal menggunakan arahan Union.
Arahan:
Klik ikon Union
Select objects: pilih objek pertama kemudian pilih objek kedua.
Select objects: tekan enter untuk menghasilkan Union

7.6.2 Penyingkiran (Subtract)

Arahan Subtract bertujuan untuk melakukan penyingkiran pepejal seperti menghasilkan lubang
yang berbentuk silinder atau membuang bahagian yang tidak diperlukan.

Gabungkan dua objek pepejal seperti di
atas pastikan objek tersebut sebaris.

Selepas melakukan arahan Subtract.

Rajah 7.19 Pembentukan model pepejal menggunakan arahan Subtract.

Arahan:
Klik ikon Subtract
Select objects: pilih objek pertama iaitu objek yang paling besar dahulu.
Select objects: tekan enter
Select objects: pilih objek yang kedua iaitu objek paling kecil
Select objects: tekan enter dan terbentuklah objek yang telah melalui arahan penolakan.

7.6.3 Penyilangan (Intersect)

Arahan pembentukan penyilangan adalah untuk menghasilkan persilangan pepejal daripada
percantuman beberapa objek pepejal yang lain.
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Gabungkan dua objek pepejal seperti di
atas, pastikan objek tersebut sebaris.

Selepas melakukan arahan Intersect.

Rajah 7.20 Pembentukan model pepejal menggunakan arahan Intersect.

Arahan:
Klik ikon Intersect
Select objects: pilih objek pertama kemudian pilih objek kedua.
Select objects: tekan enter untuk menghasilkan Intersect.

Apa yang menariknya tentang arahan Intersect ialah bentuk 3D yang melengkung dapat
dihasilkan seperti yang di tunjukkan dalam Rajah 7.21 di bawah.

Sebelum arahan Intersect, dua objek
pepejal dihasilkan seperti di atas.

Selepas melakukan arahan Intersect.

Rajah 7.21 Arahan Intersect.

7.7 Arahan keratan (Section)

Pembentukan keratan pepejal atau solid section digunakan untuk mendapatkan keratan rentas
2D secara automatik. Penentuan keratan rentas diambil dari persilangan antara satah
pembinaan antara satah pembinaan yang merujuk kepada satah XY pada UCS semasa dan
objek pepejal yang dipilih. Oleh itu kedudukan UCS adalah amat penting untuk menentukan
satah keratan yang dikehendaki. Pilih arahan section dari tiga jenis arahan seperti di bawah:

i. Dari Solid Toolbar
ii. Dari Pull-down Menu ( Draw > Solids > Section)
iii. Dengan menggunakan keyboard ( sec atau section)
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Sebelum arahan Section, pastikan UCS
berada dalam kedudukan paksi keratan
iaitu XY seperti di atas.

Selesai sahaja dialihkan objek pepejal
maka keratan terhasil

Rajah 7.22 Arahan Section bertujuan untuk menghasilkan keratan.

Arahan:
Klik ikon Section
Select objects: pilih objek pepejal.
Select objects: tekan enter
Specify first point on Section plane by [Object/Zaxis/View/XY/YZ/ZX/3points]
<3points>: taipkan xy
Select objects: tekan enter bermaksud setuju dengan default yang diberikan.

7.8 Arahan Kerat (Slice)

Arahan ini digunakan untuk mengerat atau pemotongan komponen pepejal menjadi dua
bahagian berasingan. Satah keratan ditentukan dahulu berdasarkan kedudukan UCS. Bentuk
bongkah yang dikerat ditunjukkan dalam Rajah 7.23. Pilih arahan slice dari tiga jenis arahan
seperti di bawah:

i. Dari Solid Toolbar
ii. Dari Pull-down Menu ( Draw > Solids > Slice)
iii. Dengan menggunakan keyboard ( sl atau section)
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Sebelum arahan Slice, pastikan UCS
berada dalam kedudukan paksi keratan
iaitu XY seperti di atas.

Selesai sahaja dialihkan objek pepejal
maka pemotongan terhasil

Rajah 7.23 Arahan Slice bertujuan untuk keret pepejal kepada dua bahagian.

Arahan:
Klik ikon Slice
Select objects: pilih objek pepejal.
Select objects: tekan enter
Specify first point on slicing plane by [Object/Zaxis/View/XY/YZ/ZX/3points]
<3points>: taipkan xy
Specify a point on the XY-plane <0,0,0>: tekan enter bermaksud setuju dengan default yang
diberikan.

7.9 Arahan Kambi (Fillet)

Arahan kambi pepejal atau dikenali sebagai solid fillet digunakan untuk membentuk kambi pada
tepian atau bucu yang tajam atau yang mempunyai bucu bersudut 90. Arahan ini memerlukan
pemilihan tepi objek dan jejari kambi.
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Sebelum arahan Fillet. Selesai sahaja arahan Fillet dilakukan.

Rajah 7.24 Arahan kambi atau fillet.

Arahan:
Klik ikon Fillet
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: pilih r untuk jejari
Specify fillet radius <0>: masukkan 5 sebagai jejari bergantung kepada saiz objek.
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: pilih titik A sebagai edge
Enter fillet radius <5>: tekan enter sebagai setuju
Select an edge or [Chain/Radius]: tekan enter sebagai setuju juga
1 edge(s) selected for fillet.

7.10 Arahan Serongan (Chamfer)

Arahan serongan sama seperti arahan fillet iaitu untuk menghasilkan serongan pada bucu
tajam. Serongan ini bersudut 45.

A
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Sebelum arahan Chamfer Arahan Chamfer telah dilakukan.

Rajah 7.24 Arahan serongan atau chamfer.

Arahan:
Klik ikon Chamfer
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]: taipkan d untuk
distance
Specify first chamfer distance <>: masukkan distance 5 bergantung kepada saiz objek
Specify second chamfer distance <>: masukkan distance lagi satu iaitu 5
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]: pilih titik A
Enter surface selection option [Next/OK (current)] <OK>: tekan enter
Specify base surface chamfer distance <5>: tekan enter
Specify other surface chamfer distance <5>: tekan enter
Select an edge or [Loop]: taipkan l bermaksud Loop
Select an edge loop or [Edge]: pilih titik A sekali lagi
Select an edge loop or [Edge]: tekan enter

A
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7.11 Contoh Latihan

Rajah 7.25

Arahan kepada soalan latihan

Hasilkan lukisan 3D dari soalan Ortografik di atas.

Formatkan lukisan anda terlebih dahulu

Dengan menggunakan Drawing unit dialog box, setkan unit kepada decimal.

Cadangan arahan

Mulakan dengan melukis bentuk silinder yang besar dahulu dengan menggunakan ikon silinder
atau dengan menggunakan pedit pada bulatan seperti yang ditunjukkan di bawah ini.

Langkah 1

Untuk melukis di dalam pandangan 3D terlebih dahulu tukarkan pandangan kepada SW
Isometric. Tukarkan UCS menggunakan paksi X dengan sudut putaran seperti di dalam Rajah
7.26.

Asal Selepas menggunakan UCS
paksi X

Rajah 7.26



Model Pepejal 3D18

Langkah 2

Buatkan silinder berdiameter 40 mm dengan panjang 30 mm.

Klik ikon Circle
Specify radius of circle or [Diameter] <20>: masukkan jejari atau radius 20 dan enter.

Klik ikon Extrude
Select objects: pilih bulatan pertama
Select objects: tekan enter
Specify height of extrusion or [Path]: masukkan 30 dan enter
Specify angle of taper for extrusion <0>: enter bermaksud tiada kecerunan

Langkah 3

Buat silinder yang kedua dengan diameter 28 pada pusat yang sama dengan silinder pertama.

Klik ikon circle
Specify radius of circle or [Diameter] <20>: masukkan jejari atau radius 14 dan enter.

Klik ikon Extrude
Select objects: pilih bulatan kedua
Select objects: tekan enter
Specify height of extrusion or [Path]: masukkan 50 dan enter
Specify angle of taper for extrusion <0>: enter bermaksud tiada kecerunan

Rajah 7.27

Langkan 4

Lakukan arahan Chamfer dengan jarak 5.

Klik ikon Chamfer
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]: taibkan d untuk
distance
Specify first chamfer distance <0>: masukkan distance 5
Specify second chamfer distance <0>: masukkan distance lagi satu iaitu 5
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]: pilih bucu untuk
Chamfer
Enter surface selection option [Next/OK (current)] <OK>: tekan enter
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Specify base surface chamfer distance <5>: tekan enter
Specify other surface chamfer distance <5>: tekan enter
Select an edge or [Loop]: taipkan l bermaksud Loop
Select an edge loop or [Edge]: pilih bucu sekali lagi
Select an edge loop or [Edge]: tekan enter

Rajah 7.28

Langkah 5

Buatkan sebuah segi empat sama seperti di bawah dengan menggunakan arahan Rectangle.

Rajah 7.29

Lakukan araha Extrude
Klik ikon Extrude
Select objects: klik pada garisan segi empat sama yang telah dihasilkan
Select objects: tekan butang enter bermaksud tiada lagi objek yang dipilih.
Specify height of extrusion or [Path]: masukkan ketinggian objek iaitu 60 mm.
Specify angle of taper for extrusion <0>: tekan butang enter

Rajah 7.30
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Langkah 6

Langkah 6 bertujuan untuk meletakkan kubah tersebut ke dalam silinder yang telah dihasilkan.
Seperti dalam Rajah 7.31 di bawah. Sebelum menggunakan arahan Remove, buatkan garisan
rujukan sebagai titik tangkap semasa diletakkan bungkah tersebut.

Langkah 7

Arahan Subtract untu

Klik ikon Subtract
Select objects: pilih
Select objects: teka
Select objects: pilih
Select objects: teka
seperti Rajah 7.32.
Garisan menegak sepanjang 19 mm
dan bulatan berdiameter 28 mm
Rajah 7.31

k membuang bahagian atas yang tidak diperlukan.

silinder pertama dan kedua.
n enter
kubah
n enter dan terbentuklah objek yang telah melalui arahan penyingkiran

dibina terlebih dahulu.
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Rajah 7.32

Langkah 8

Langkah untuk menebuk lubang tembus pada bahagia tengah iaitu pada jarak 30 mm dari
permukaan dalam Rajah 7.33 dan buatkan garis lurus panjang 30 mm. sebelum itu tukarkan
UCS pada paksi X dengan sudut putaran -90. Tetapi sebulum itu tukarkan UCS seperti di
tunjukkan dalam Rajah 7.33 di bawah.

Arahan Line
Command: _line Specify first point: pilih titik mula
Specify next point or [Undo]: taipkan @30<90 dan enter.

Rajah 7.33

Klik ikon Circle
Command: _circle Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: pilih titik X
Specify radius of circle or [Diameter] <14>: masukkan jejari 6 dan enter
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Klik ikon Extrude
Select objects: klik pada bulatan yang telah dihasilkan
Select objects: tekan butang enter bermaksud tiada lagi objek yang dipilih.
Specify height of extrusion or [Path]: masukkan ketinggian objek iaitu -19 mm kerana
berlawanan arah dengan paksi Z
Specify angle of taper for extrusion <0>: tekan butang enter

Klik ikon Subtract
Select objects: pilih silinder yang besar
Select objects: tekan enter
Select objects: pilih silinder yang kecil
Select objects: tekan enter dan terbentuklah objek yang telah melalui arahan penyingkiran
seperti Rajah 7.34.

Rajah 7.34

Untuk mendapatkan bentuk seperti Rajah 7.35 di bawah;
Taipkan arahan DISPSILH dan enter
Enter new value for DISPSILH <0>: taipkan 1 dan enter.

Pergi ke Pull-down menu (View > Hide).

Rajah 7.35
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7.11 Mengubah lukisan 3D kepada pandangan Ortografik

Apabila lukisan 3D telah dihasilkan maka dengan mudah sekali anda dapat menghasilkan
lukisan ortografik secara terperinci tanpa tertinggal sebarang garisan atau garisan tersembunyi.
Arahan-arahan yang digunakan adalah seperti solprof. Beberapa unjuran lukisan 2D boleh
dihasilkan dengan hanya melukis objek 3D. Ia secara tidak langsung dapat mempercepatkan
lukisan 2D dengan terperinci.

7.11.1 Arahan Solprof.

Arahan ini bermaksud susukan pepejal untuk membentuk imej objek pepejal 3D kepada 2D.
Arahan ini dapat membantu menghasilkan lukisan orthografik dan isometrik dengan mudah.
Arahan ini hanya boleh dilakukan pada paper space sahaja. Pindahkan ke ruang pemodelan
dengan menaip arahan mview atau pergi kepada menu dan pilih viewports kemudian ikut
arahannya seperti diberikan dibawah:

Di dalam ruang paper space
Taipkan mview dan tekan enter
Specify corner of viewport or
[ON/OFF/Fit/Shadeplot/Lock/Object/Polygonal/Restore/2/3/4] <Fit>: pilih 4
Specify first corner or [Fit] <Fit>: tekan enter bermaksud setuju

Taipkan mspace dan enter
Kemudian taipkan solprof dan enter
Select objects: pilih objek yang telah dihasilkan
Select objects: tekan enter
Display hidden profile lines on separate layer? [Yes/No] <Y>: tekan enter
Project profile lines onto a plane? [Yes/No] <Y>: tekan enter
Delete tangential edges? [Yes/No] <Y>: tekan enter
Enter an option [?/Freeze/Thaw/Reset/Newfrz/Vpvisdflt]:
Command:
One solid selected.

Kemudian buka bahagian Layer properties manager dan wujudnya PH. dan PV. seperti
ditunjukkan dalam Rajah 7.36.

Rajah 7.36

Seterusnya anda harus klik pada bahagian Cur (Current) seperti di dalam Rajah 7.37 dan
seterusnya tekan butang OK.

Klik di sini
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Rajah 7.37

Anda akan dapati lukisan telah menghasilkan garis putus-putus pada bahagian tersembunyi
dengan syarat pada PH-1A3 (PH dengan H bermaksud hidden) garisan Continuous telah
ditukar kepada garisan Hidden.

Rajah 7.38
7.12 Binaan Pepejal 3D Asas

Model pepejal 3D telah dipelajari pada bahagian awal di dalam bab ini seperti penggunaan
arahan PEDIT untuk menghasilkan bungkah segi empat misalnya. Walau begitu masih ada
kaedah yang lebih mudah untuk menghasilkan bungkah segi empat iaitu dengan
menggunaakan arahan Box. Tujuan bahagian ini diterangkan kemudian adalah untuk memberi
laluan atau penjelasan awal kepada penggunaan arahan PEDIT. Terdapat enam jenis arahan
iaitu Box, Sphere, Cylinder, Cone, Wedge dan Torus.

7.12.1 Arahan Box

Gunakan arahan Box untuk menghasilkan model pepejal 3D bungkah segi empat.
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Rajah 7.39 Model pepejal box.

Klik ikon Box.
Specify corner of box or [Enter] <0,0,0>: masukkan kordinat 20,20 pada titik A dan enter
Specify corner or [Cube/Length]: L (untuk panjang kotak) dan enter
Specify length: 100 (arah X) dan enter
Specify width: 50 (arah Y) dan enter
Specify height: 50 (arah Z) dan enter

7.12.2 Arahan Cone

Model pepejal kon dihasilkan dengan melukis bulatan atau bentuk elips terlebih dahulu.

Rajah 7.39 Model pepejal kon.
Klik ikon Cone
Current wire frame density: ISOLINES=4
Specify center point for base of cone or [Elliptical] <0,0,0>: masukkan koordinat awal atau
dengan menggunakan mouse klik pada mana-mana kawasan di dalam drawing area.
Specify radius for base of cone or [Diameter]: 30 (jejari) dan enter
Specify height of cone or [Apex]: 60 (tinggi) dan enter

7.12.3 Arahan Wedge

Arahan wedge sama dengan arahan Box.

Rajah 7.40 Model pepejal wedge.

A

A



Model Pepejal 3D26

Klik ikon Box.
Specify corner of box or [CEnter] <0,0,0>: masukkan koordinat 20,20 pada titik A dan enter
Specify corner or [Cube/Length]: L (untuk panjang kotak) dan enter
Specify length: 100 (arah X) dan enter
Specify width: 50 (arah Y) dan enter
Specify height: 50 (arah Z) dan enter

7.12.4 Arahan Cylinder

Arahan Cylinder sama dengan arahan Cone

Rajah 7.41 Model pepejal silinder.
Klik ikon Cylinder
Current wire frame density: ISOLINES=4
Specify center point for base of cylinder or [Elliptical] <0,0,0>: masukkan koordinat awal
atau dengan menggunakan tetikus klik pada mana-mana kawasan di dalam drawing area.
Specify radius for base of cone or [Diameter]: 30 (jejari) dan enter
Specify height of cylinder or [Apex]: 60 (tinggi) dan enter

7.12.5 Arahan Sphere

Arahan ini digunakan untuk membina pepejal sfera dengan mengenal pasti pusat sfera dan
juga jejari atau diameter sfera.

Isolines = 4 Menggunakan Isolines = 10

Rajah7.42 Medel pepejal sfera.
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Klik ikon Sphere
Current wire frame density: ISOLINES=4
Specify center of sphere <0,0,0>: masukkan koordinat atau hanya klik pada mana-mana
drawing area.
Specify radius of sphere or [Diameter]: d (sebagai diameter) dan enter
Specify diameter: 60 dan enter

Dalam rajah sebelah kiri bentuk sfera yang dilukis tidak kelihatan seperti sfera kerana hanya
ada 4 garisan iso atau isolines = 4. Isolines harus ditukar kepada 8 atau 10 supaya kelihatan
seperti sfera.

Sebelum itu

Taipkan isolines dan enter
Enter new value for ISOLINES <4>: masukkan10 enter

Klik ikon Sphere
Current wire frame density: ISOLINES=10
Specify center of sphere <0,0,0>: masukkan kordinat atau hanya klik pada mana-mana
drawing area.
Specify radius of sphere or [Diameter]: d dan enter
Specify diameter: 60 dan enter

7.12.6 Arahan Torus

Torus terbentuk dari bulatan kemudian diputarkan pada pusatnya. Bentuknya hampir kepada
donut 3D. Torus dibina melalui keadah jejari atau kaedah diameter.

Kaedah jejari Kaedah diameter

Rajah 7.43 Perbezaan kaedah jejari dan diameter.

Arahan menggunakan kaedah jejari
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Klik ikon Torus
Current wire frame density: ISOLINES=10
Specify center of torus <0,0,0>: masukkan koordinat atau hanya klik pada mana-mana
drawing area.
Specify radius of torus or [Diameter]: r untuk jejari dan enter
Requires numeric distance, second point, or option keyword.
Specify radius of torus or [Diameter]: 60 dan enter
Specify radius of tube or [Diameter]: 20 dan enter

Arahan menggunakan kaedah diameter
Klik ikon Torus
Current wire frame density: ISOLINES=10
Specify center of torus <0,0,0>: masukkan koordinat atau hanya klik pada mana-mana
drawing area.
Specify radius of torus or [Diameter]: d untuk diameter dan enter
Specify diameter: 120 dan enter
Specify radius of tube or [Diameter]: d untuk diameter dan enter
Specify diameter: 40 dan enter

7.13 Kawalan Paparan

Kawalan paparan digunakan untuk mendapatkan paparan model pepejal lebih jelas atau objek
yang dihasilkan nampak lebih menarik. Terdapat tiga kaedah kawalan paparan iaitu Isolines,
facetres dan Dispsilh.

7.13.1 Kawalan Isolines

Menentukan bilangan garisan per permukaan bagi bentuk model pepejal 3D. Sistem AutoCAD
telah mempunyai nilai Isolines = 4 iaitu nilai asas telah ditetapkan.

Isolines = 4 Menggunakan Isolines = 30

Rajah 7.44 Penentuan garis isometrikobjek pepejal.

Taipkan arahan Isolines
Enter new value for ISOLINES <4>: 30 (masukkan nilai 30) dan enter
Selepas itu gunakan arahan atau taipkan regen untuk melihat perubahan selepas arahan
tersebut.
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7.13.2 Kawalan Facetres

Untuk mengawal keamatan permukaan. Nilai yang akan diubah mempengaruhi kelicinan
permukaan model. Nilai yang perlu dimasukkan di antara 0.50 hingga 10.0.

Facetres = 0.50 Facetres = 10.0

Rajah 7.45 Perbezaan kualiti keamatan permukaan.

Taipkan arahan Facetres
Enter new value for FACETRES <0.5000>: 2 dan enter
Selepas itu gunakan arahan Hide untuk melihat perubahan selepas arahan tersebut.

7.13.3 Kawalan Dispsilh

Untuk mengawal paparan garisan menjadi paparan isometrik dengan menghilangkan garisan
dawai. Nilai awalan yang disetkan ialah 0 bermaksud Off dan 1 bermaksud On.

Wireframe Hidden Wireframe Hidden

DISPSILH = 0 (OFF) DISPSILH = 1 (ON)

Rajah 7.46 Kawalan paparan permukaan pepejal.

Taipkan arahan dispsilh
Enter new value for DISPSILH <0>: 1 untuk On
Selepas itu gunakan arahan Hide untuk melihat perubahan selepas arahan tersebut.
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7.14 Mengubah Objek Pepejal 3D kepada Pandangan Ortografik (Pelan, Hadapan dan
Sisi)

Objek pepejal 3D yang dihasilkan melalui lukisan AutoCAD boleh diubah bentuk kepada
pandangan Ortografik dengan memahami beberapa kaedah yang akan dijelaskan selepas ini.

Terdapat beberapa kaedah yang berbeza bergantung kepada versi perisian AutoCAD yang
digunakan. Walaubagaimanapun secara keseluruhannya konsep yang digunakan untuk
mengubah pepejal 3D kepada pandangan ortografik adalah sama secara amnya. Sebelum
melakukan proses ini, terlebih dahulu objek pepejal 3D hendaklah dilukis seperti Rajah 7.47 di
bawah tanpa dimensi.

Rajah 7.47 Objek pepejal 3D.

Apabila selesai melukis objek pepejal 3D tukarkan pandangan dari Model kepada Layout 1
seperti ditunjukkan dalam Rajah 7.48. Sila ikuti beberapa langkah yang yang perlu dilakukan
sebagai proses menukar objek pepejal 3D kepada Ortografik.

Langkah 1.

Tukar pandangan dari Model kepada Layout 1

Rajah 7.48 Tukar dari Model kepada Layout 1.
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Pandangan Layout bertujuan untuk mengubah lukisan 3D kepada pandangan Ortografik.

Langkah 2

Dari pulldown menu klik View dan selepas itu cari Viewports dan klik Names Viewports. Satu
Dialogue Box Viewports akan tertera. Di dalam Dialogue Box tersebut tukarkan dari Names
Viewports kepada New Viewports, kemudian klik Four: Equal di dalam Standard Viewports. Di
dalam Setup pastikan ia 3D. Masih di dalam Dialogue Box tersebut untuk menghasilkan
unjuran sudut pertama atau unjuran sudut ketiga arahan seterusnya hendaklah diikuti. Sebagai
contoh untuk menghasilkan unjuran sudut pertama di mana pandangan hadapan berada di
sebelah kiri atas kotak, oleh itu perlu dibuat perubahan terhadap kotak atas sebelah kiri kepada
Front. Arahan untuk mengubah kepada Front terdapat pada Change view to; seterusnya
lakukan pandangan pelan dan sisi seperti ditunjukkan dalam Rajah 7.49.

Rajah 7.49 Arahan untuk menghasilkan unjuran sudut pertama.

Selepas itu klik butang OK. AutoCAD akan meminta untuk anda melakukan arahan seterusnya
iaitu Fit, anda hanya perlu tekan Enter sahaja bermaksud menerima arahan tersebut.

Untuk menghasilkan unjuran sudut ketiga dengan pandangan hadapan seperti ditunjukkan
dalam Rajah 7.50 di bawah.
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Rajah 7.50 Arahan untuk menghasilkan unjuran sudut ketiga.

Langkah 3

Pastikan hanya tinggal empat pandangan sahaja dengan pandangan ditengah telah dibuang
seperti Rajah 7.51. Anda boleh mengubah saiz setiap satu objek di dalam kotak tersebut
dengan double click salah satu kotak yang hendak diubah seperti dalam Rajah di atas.

Rajah 7.51
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Langkah 4

Double click pada pandangan isometric. Kemudian klik ikon Profile seperti dalam Rajah 7.52 di
bawah.

Rajah 7.52 Ikon Profile di dalam Solids tool bar.

Ikut arahan seperti di bawah:

Klik ikon Profile
Command: _solprof
Select objects: pilih objek

Select objects: tekan enter
Display hidden profile lines on separate layer? [Yes/No] <Y>: pilih Y bermaksud setuju
Project profile lines onto a plane? [Yes/No] <Y>: pilih Y bermaksud setuju
Delete tangential edges? [Yes/No] <Y>: pilih Y bermaksud setuju
Seterusnya AutoCAD akan memproses arahan tersebut.

Kemudian klik Layer Propertise Manager, seterusnya setkan pada bahagian Current iaitu pada
bahagian 0 dan PH-113 (PH-113 dan PV-113 akan berlainan nilainya jika anda menggunakan
PC sendiri) seperti dalam Rajah 7.53. Apabila selesai dan tekan Enter, objek ISOMETRIK telah
bertukar menjadi seperti Rajah 7.54.

Rajah 7.53

Klik di sini

Klik di sini
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Rajah 7.54

Langkah 5

Ulang Proses yang sama bagi pandangan seterusnya seperti Pandangan Sisi, Hadapan dan
Pelan cuma perbezaannya hanyalah garisan dapan PH hendaklah ditukar kepada Hidden Line.

Pandangan Sisi

Double click pada pandangan hadapan.

Klik ikon Profile
Command: _solprof
Select objects: pilih objek

Select objects: tekan enter
Display hidden profile lines on separate layer? [Yes/No] <Y>: pilih Y bermaksud setuju
Project profile lines onto a plane? [Yes/No] <Y>: pilih Y bermaksud setuju
Delete tangential edges? [Yes/No] <Y>: pilih Y bermaksud setuju
Seterusnya AutoCAD akan memproses arahan tersebut.

Kemudian klik Layer Propertise Manager, seterusnya setkan pada bahagian Current iaitu pada
bahagian 0 dan PH-115 dan juga PV-115 (PH-115 dan PV-115 akan berlainan nilainya jika
anda menggunakan PC sendiri) seperti dalam Rajah 7.55. Apabila selesai dan tekan Enter,
objek ISOMETRIK telah bertukar menjadi seperti Rajah 7.56.
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Rajah 7.55

Rajah 7.56

Langkah 6

Ulang Proses yang sama bagi pandangan seterusnya seperti Pandangan Hadapan dan Pelan
cuma perbezaannya hanyalah garisan dapan PH hendaklah ditukar kepada Hidden Line.

Pandangan Hadapan

Double click pada pandangan hadapan.

Klik di sini

Klik di sini

Klik di sini

Tukar garisan
ini menjadi
Hidden
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Klik ikon Profile
Command: _solprof
Select objects: pilih objek

Select objects: tekan enter
Display hidden profile lines on separate layer? [Yes/No] <Y>: pilih Y bermaksud setuju
Project profile lines onto a plane? [Yes/No] <Y>: pilih Y bermaksud setuju
Delete tangential edges? [Yes/No] <Y>: pilih Y bermaksud setuju
Seterusnya AutoCAD akan memproses arahan tersebut.

Kemudian klik Layer Propertise Manager, seterusnya setkan pada bahagian Current iaitu pada
bahagian 0 dan PH-117 dan juga PV-117 (PH-117 dan PV-117 akan berlainan nilainya jika
anda menggunakan PC sendiri) seperti dalam Rajah 7.57. Apabila selesai dan tekan Enter,
objek ISOMETRIK telah bertukar menjadi seperti Rajah 7.58.

Rajah 7.57

Klik di sini

Klik di sini

Klik di sini
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Rajah 7.59

Langkah 7

Ulang Proses yang sama bagi pandangan seterusnya seperti Pandanga Pelan cuma
perbezaannya hanyalah garisan dapan PH hendaklah ditukar kepada Hidden Line.

Pandangan Pelan

Double click pada pandangan hadapan.

Klik ikon Profile
Command: _solprof
Select objects: pilih objek

Select objects: tekan enter
Display hidden profile lines on separate layer? [Yes/No] <Y>: pilih Y bermaksud setuju
Project profile lines onto a plane? [Yes/No] <Y>: pilih Y bermaksud setuju
Delete tangential edges? [Yes/No] <Y>: pilih Y bermaksud setuju
Seterusnya AutoCAD akan memproses arahan tersebut.

Kemudian klik Layer Propertise Manager, seterusnya setkan pada bahagian Current iaitu pada
bahagian 0 dan PH-111 dan juga PV-111 (PH-111 dan PV-111 akan berlainan nilainya jika
anda menggunakan PC sendiri) seperti dalam Rajah 7.60. Apabila selesai dan tekan Enter,
objek ISOMETRIK telah bertukar menjadi seperti Rajah 7.61.
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Rajah 7.60

Rajah 7.61

Langkah 8

Setelah semua arahan di atas telah dilaksanakan, anda boleh masukkan dimensi ke atas
lukisan anda.
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Soalan Latihan

Latihan 1

Arahan bagi latihan 1 – 2
Bina sebuah pepejal 3D dari pandangan ortografik yang diberikan. Semua unit dalam mm.
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Latihan 2
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Latihan 3

Arahan bagi latihan 3 – 14
Bina sebuah pepejal 3D bagi setiap objek yang diberikan. Semua unit dalam mm.



Model Pepejal 3D42

Latihan 4
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Latihan 5
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Latihan 6
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Latihan 7
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Latihan 8
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Latihan 9
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Latihan 10
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Latihan 11
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Latihan 12
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Latihan 13
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Latihan 14


